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1. Ważne

1.	 Ważne
Ten elektroniczny podręcznik użytkownika jest 
przeznaczony dla wszystkich użytkowników 
monitora Philips. Należy poświęcić trochę czasu 
na przeczytanie tego podręcznika użytkownika, 
przed rozpoczęciem używania monitora. Zawiera 
on ważne informacje i uwagi dotyczące używania 
monitora.

Produkt firmy Philips jest objęty gwarancją pod 
warunkiem właściwej obsługi i używania go zgodnie 
z przeznaczeniem i z właściwymi instrukcjami 
obsługi oraz po przedstawieniu oryginału faktury 
lub paragonu kasowego, zawierającego datę 
zakupu, nazwę dostawcy oraz model i numer 
seryjny produktu.

1.1	 Środki bezpieczeństwa i 
konserwacja

	 Ostrzeżenia
Używanie elementów sterowania, regulacji lub 
innych procedur niż te, które opisano w niniejszej 
dokumentacji, może spowodować porażenie 
prądem i/lub zagrożenia mechaniczne.
Należy przeczytać i zastosować się do podanych 
instrukcji podczas podłączania i używania monitora 
komputerowego:

Działanie
•	 Monitor należy chronić przed bezpośrednim 

światłem słonecznym, bardzo silnym, jasnym 
światłem i trzymać go z dala od źródła 
ciepła. Długotrwała ekspozycja na tego 
rodzaju środowisko, może spowodować 
rozbarwienie i uszkodzenie monitora.

•	 Należy usunąć jakiekolwiek obiekty, które 
mogą blokować szczeliny wentylacyjne 
lub uniemożliwić prawidłowe chłodzenie 
elementów elektronicznych monitora.

•	 Nie wolno blokować szczelin wentylacyjnych 
obudowy.

•	 Podczas ustawiania monitora należy upewnić 
się, że zapewniony jest łatwy dostęp do 
wtyki i gniazda zasilania.

•	 Jeśli monitor został wyłączony poprzez 
odłączenie kabla zasilającego lub przewodu 
prądu stałego, w celu uzyskania normalnego 
działania, należy zaczekać 6 sekund przed 

ponownym podłączeniem kabla zasilającego 
lub przewodu prądu stałego.

•	 Przez cały czas eksploatacji monitora, 
należy używać przewodów zasilających z 
certyfikatem, dostarczonych przez firmę 
Philips. Brak przewodu zasilającego należy 
zgłosić do lokalnego punktu serwisowego. 
(Sprawdź informacje w części Centrum 
informacji opieki nad klientem)

•	 W czasie działania nie należy narażać 
monitora na silne drgania lub uderzenia.

•	 Podczas działania lub przenoszenia nie 
należy uderzać lub dopuszczać do upadku 
monitora.

Konserwacja
•	 Aby chronić monitor przed możliwym 

uszkodzeniem nie należy nadmiernie naciskać 
na panel LCD. Podczas przenoszenia 
monitora, przy podnoszeniu należy chwytać 
za ramę; nie należy podnosić monitora 
umieszczając ręce lub palce na panelu LCD.

•	 Jeśli monitor nie będzie używany w dłuższym 
okresie czasu, należy go odłączyć od 
zasilania.

•	 Przed czyszczeniem lekko zwilżoną szmatką 
należy odłączyć monitor od zasilania. 
Ekran można wycierać suchą szmatka, przy 
wyłączonym zasilaniu. Jednakże, nigdy nie 
należy używać do czyszczenia monitora 
rozpuszczalników organicznych, takich jak 
alkohol lub opartych na amoniaku płynów.

•	 Aby uniknąć ryzyka porażenia lub trwałego 
uszkodzenia zestawu, nie należy narażać 
monitora na działanie kurzu, deszczu, wody, lub 
nadmiernej wilgoci.

•	 Po zamoczeniu monitora, należy go jak 
najszybciej wytrzeć suchą szmatką.

•	 Jeśli do wnętrza monitora przedostanie się 
obca substancja lub woda, należy natychmiast 
wyłączyć zasilanie i odłączyć przewód zasilający. 
Następnie, należy usunąć obcą substancję 
lub wodę i wysłać monitor do punktu 
naprawczego.

•	 Nie należy przechowywać lub używać 
monitora w miejscach narażonych na 
oddziaływanie ciepła, bezpośredniego 
światła słonecznego lub ekstremalnie niskich 
temperatur.
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•	 Aby zapewnić najlepsze funkcjonowanie 
monitora i jego długą żywotność należy go 
używać w miejscach, w których temperatura 
i wilgotność mieści się w podanym zakresie.
•	 Temperatura: 0 - 40°C 32 - 95°F
•	 Wilgotność: 20 - 80% RH

Ważne informacje dotyczące wypalania obrazu/
powidoku
•	 Po pozostawieniu monitora bez nadzoru 

należy zawsze uaktywniać program 
wygaszacza ekranu z ruchomym obrazem. 
Aby zapobiec pozostawaniu na monitorze 
trwałego, statycznego obrazu należy zawsze 
uaktywniać aplikację do okresowego 
odświeżania ekranu. Wydłużone 
nieprzerwane wyświetlanie stałych lub 
nieruchomych obrazów, może spowodować 
na ekranie "wypalenie", znane również jako 
"powidok" lub "poobraz".
"Wypalenie", "poobraz" lub "powidok" to 
dobrze znane zjawisko dotyczące technologii 
LCD. W większości przypadków, "wypalenie" 
lub "powidok" albo "poobraz" znika 
stopniowo po pewnym czasie od wyłączenia 
zasilania.

	 Ostrzeżenie
Nie uaktywnianie wygaszacza ekranu lub 
aplikacji okresowego odświeżania ekranu, może 
spowodować poważne symptomy "wypalenia" 
lub "poobrazu" albo "powidoku", które nie znikną 
i nie można będzie ich naprawić. Wspomniane 
uszkodzenie nie podlega gwarancji.

Serwis
•	 Pokrywę obudowy może otwierać wyłącznie 

wykwalifikowany personel serwisu.
•	 Jeśli wymagane są jakiekolwiek dokumenty 

dotyczące naprawy lub integracji należy 
się skontaktować z lokalnym punktem 
serwisowym. (sprawdź rozdział "Centrum 
informacji klienta")

•	 Informacje dotyczące transportu, można 
uzyskać w części "Specyfikacje techniczne".

•	 Nie wolno pozostawiać monitora w 
samochodzie/bagażniku nagrzewanym 
bezpośrednimi promieniami słońca.

	 Uwaga
Jeśli monitor nie działa normalnie, lub gdy nie 
ma pewności, którą procedurę zastosować 
podczas wykonywania instrukcji działania należy 
skontaktować się z technikiem serwisu.

1.2	 Konwencje zapisu
Konwencje zapisu zastosowane w niniejszym 
dokumencie wykorzystują następujące elementy:

Uwagi, przestrogi i ostrzeżenia
W tej instrukcji pewne bloki tekstu mogą być 
wyróżnione poprzez zastosowanie pogrubienia 
lub pochylenia czcionki, mogą też towarzyszyć im 
ikony. Bloki takie zawierają uwagi, przestrogi lub 
ostrzeżenia. Są one wykorzystywane w następujący 
sposób:

	 Uwaga
Ta ikona wskazuje ważną informację i poradę, 
pomocną w lepszym wykorzystaniu możliwości 
sprzętu.

	 Przestroga
Ta ikona wskazuje informacje, jak uniknąć 
potencjalnego uszkodzenia sprzętu lub utraty 
danych.

	 Ostrzeżenie
Ta ikona wskazuje możliwość powstania zagrożenia 
dla zdrowia lub życia oraz wskazuje sposób 
uniknięcia problemu.
Niektóre ostrzeżenia mogą mieć inną formę oraz 
występować bez ikon. W takich przypadkach 
określony sposób prezentacji ostrzeżenia jest 
wskazywany przez odpowiednie przepisy.
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1.3	 Usuwanie produktu i materiałów 
opakowania

Utylizacja odpadów elektrycznych i 
elektronicznych - WEEE

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2002/96/EC governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 
your local government office, the waste disposal 
organization that serves your household or the 
store at which you purchased the product.

Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 

All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

Please find out about the local regulations on 
how to dispose of your old monitor and packing 
from your sales representative. 

Taking back/Recycling Information for 
Customers

Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation in national take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors, 
which recycle all materials (products and related 
packaging material) in accordance with all 
Environmental Laws and taking back program 
with the contractor company.  

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit 

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page

http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
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	 Instalacja podstawy
1.	 Monitor należy umieścić ekranem w dół 

na miękkiej i gładkiej powierzchni uważając, 
aby uniknąć porysowań lub uszkodzenia 
ekranu.

2.	 Podłącz kolumnę podstawy do monitora, aż 
do kliknięcia na pozycję.

3.	 Przytrzymaj podstawę monitora 
obydwiema rękami i pewnie zamontuj 
podstawę na kolumnie podstawy.

2.	 Ustawienia monitora

2.1	 Instalacja

	 Zawartość opakowania
246V5Register your product and get support at

www.philips.com/welcome

Quick

Start

2013

使用产品前请阅读使用说明

保留备用

user s manual

VGA

Zasilanie

Wygląd monitora może się różnić od przedstawionego na ilustracji

Audio (opcjonalny)
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	 Podłączanie do komputera PC

246V5LAB

5

6

1 	Wejście zasilania prądem zmiennym
2 	Wejście VGA
3 	Wejście DVI-D (dla wybranych modeli)
4 	Wejście Audio (dla wybranych modeli)
5 	 �Blokada Kensington zabezpieczenia przed 
kradzieżą

6 	 Gniazdo słuchawek

246V5LHAB

5

6

1 	Wejście zasilania prądem zmiennym
2 	Wejście VGA
3 	Wejście HDMI (dla wybranych modeli)
4 	Wejście Audio (dla wybranych modeli)
5 	 �Blokada Kensington zabezpieczenia przed 
kradzieżą

6 	 Gniazdo słuchawek

246V5LSB

	Wejście zasilania prądem zmiennym
	Wejście VGA
	Wejście DVI-D (dla wybranych modeli)
	� Blokada Kensington zabezpieczenia przed 
kradzieżą

Połączenie z komputerem PC
1.	 Podłącz pewnie przewód zasilający do 

złącza z tyłu monitora.
2.	 Wyłącz komputer i odłącz kabel zasilający.
3.	 Podłącz kable sygnałowe monitora do 

złącza wideo w tylnej części komputera.
4.	 Podłącz kabel zasilający komputera i 

monitora do pobliskiego gniazda.
5.	 Włącz komputer i monitor. Jeśli na 

monitorze pojawi się obraz, oznacza to, że 
instalacja została zakończona.
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2.2	 Działanie monitora

	 Opis elementów produktu widocznych z 
przodu

Model 246V5LAB/246V5LHAB:

5

6 2347

Model 246V5LSB:

5

6 2347

WŁĄCZENIE i WYŁĄCZENIE 
zasilania monitora.
Dostęp do menu OSD.
Potwierdzenie regulacji OSD.
Powrót do poprzedniego 
poziomu menu OSD.
Regulacja poziomu jasności.

Dopasowanie menu OSD.

Regulacja głośności głośnika.

Zmiana formatu wyświetlania.

Automatyczna regulacja 
monitora.

	 Opis menu ekranowego OSD
Co to jest On-Screen Display (OSD)?
OSD (On-Screen Display [Menu ekanowe]) 
to funkcja dostępna we wszystkich monitorach 
LCD Philips. Umożliwia ona regulację przez 
użytkownika parametrów wyświetlania ekranu 
lub bezpośredni wybór funkcji monitorów 
w oknie instrukcji ekranowych. Przyjazny dla 
użytkownika interfejs ekranowy jest pokazany 
poniżej:

Model 246V5LSB:












 

Model 246V5LAB:














Model 246V5LHAB














Podstawowe i proste instrukcje dotyczące 
przycisków sterowania
W pokazanym wyżej OSD, można nacisnąć 
przyciski   na panelu przednim monitora w 
celu przesunięcia kursora i nacisnąć przycisk OK 
w celu potwierdzenia lub zmiany.
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Menu OSD
Poniżej zamieszczony jest widok ogólny 
struktury menu ekranowego OSD. Można 
go wykorzystać jako punkt odniesienia przy 
późniejszym wykonywaniu różnych regulacji.

Main menu Sub menu

Picture
Wide Screen, 4:3

0~100

0~100

Picture Format

Brightness

Contrast

OSD 
Settings

0~100

0~100

Off, 1, 2, 3, 4

5s, 10s, 20s, 30s, 60s

Horizontal

Vertical

Transparency

OSD Time Out

Setup

0~100

On, Off

Yes, No

0~100

0~100

0~100

H. Position

Auto

V. Position

Phase

Clock

Resolution 
Notification

Reset

Information

Language English Español, Français, Deutsch, Italiano,

Português, Русский 简体中文, Türkçe, 

Color 6500K, 9300K

Red: 0~100
Green: 0~100
Blue: 0~100

Color Temperature
sRGB

User Define

Audio
On, Off

On, Off

Stand-Alone

Mute

(available for selective models)

(available for selective models)

VGA

HDMI
Input

On, OffSmartContrast

DVI

On, OffOverScan

(available for selective models)

Nederlands, Svenska, Suomi, Polski, Čeština

한국어, 日本語, Maryar, Українська, 

Português do Brazil,  Ελληνική (προαιρετικός),  
繁體中文(可選),  

	 Powiadomienie o rozdzielczości
Ten monitor działa optymalnie przy jego 
rozdzielczości oryginalnej, 1920 × 1080 @ 
60 Hz. Po uruchomieniu monitora przy innej 
rozdzielczości, na ekranie zostanie wyświetlony 
komunikat alarmu: Use 1920 × 1080 @ 60 
Hz for best results (Najlepsze wyniki daje 
ustawienie 1920 × 1080 @ 60 Hz).

Alarm dotyczący wyświetlania w innej 
rozdzielczości niż rozdzielczość oryginalna, 
można wyłączyć w menu Ustawienia OSD 
(menu ekranowe).

	 Funkcje fizyczne

Nachylanie
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2.3	 Odłącz wspornik i podstawę

	 Zdejmij podstawę
Przed rozpoczęciem demontażu podstawy 
monitora należy wykonać wymienione poniżej 
instrukcje, aby uniknąć możliwych uszkodzeń lub 
obrażeń.

1.	 Umieść monitor ekranem w dół na gładkiej 
powierzchni, uważając, aby nie zarysować 
lub nie uszkodzić ekranu.

2.	 Naciśnij zatrzaski blokujące w celu 
odłączenia podstawy z kolumny podstawy.

1

3.	 Naciśnij przycisk zwolnienia w celu 
odłączenia komumny podstawy.

2

	 Uwaga
Ten monitor umożliwia montaż w standardzie 
VESA 100mm x 100mm.

100mm

100mm

	 Przestroga
Tylko do użycia z podstawą do montażu 
naściennego z certyfikatem UL o nośności 
przynajmniej 3,5 kg.
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3.2	 Philips SmartControl Lite
Nowy program SmartControl Lite Philips 
umożliwia sterowanie monitorem poprzez łatwy w 
użyciu graficzny interfejs ekranowy. Skomplikowane 
regulacje to przeszłość, ponieważ to przyjazne 
dla użytkownika oprogramowanie, prowadzi 
użytkownika przez procedury dokładnej regulacji 
rozdzielczości, kalibracji kolorów, regulacji zegara/
fazy, regulacji RGB punktu bieli, itd.

Wyposażone w najnowszą technologię algorytmu 
jądra zapewniającą szybkie przetwarzanie i 
uzyskiwanie odpowiedzi, zgodne z Windows 7, 
przyciągające wzrok dzięki animowanej ikonie 
oprogramowanie, może poprawić doznania 
podczas oglądania obrazu na monitorach Philips!

	 Instalacja
•	 Wykonaj instrukcje i dokończ instalację.
•	 Uruchomienie można wykonać po 

zakończeniu instalacji.
•	 W celu późniejszego uruchomienia należy 

kliknąć ikonę skrótu na pulpicie lub na pasku 
narzędzi.

Kreator pierwszego uruchomienia
•	 Po pierwszej instalacji oprogramowania 

SmartControl Lite nastąpi automatyczne 
wyświetlenie kreatora pierwszego 
uruchomienia.

•	 Kreator krok po kroku wykonuje czynności 
regulacji monitora.

•	 W celu późniejszego uruchomienia kreatora 
można także przejść do menu Plug-in.

•	 Dalsze opcje można dostosować bez kreatora, 
poprzez okno Standardowe.

3.	 Optymalizacja obrazu

3.1	 SmartContrast
	 Co to jest?

Wyjątkowa technologia dynamicznie analizująca 
wyświetlane treści i automatycznie optymalizująca 
współczynnik kontrastu monitora LCD 
dla uzyskania maksymalnej przejrzystości i 
odpowiedniego widoku, zmieniająca stopniowo 
podświetlenie dla uzyskania bardziej czystych, 
wyraźnych i jaśniejszych obrazów lub 
przyciemnienia dla uzyskania wyraźnych obrazów 
na ciemnych tłach.

	 Dlaczego jest mi to potrzebne?
Wymagana jest najlepsza klarowność wizualna i 
komfort podczas oglądania wszystkich rodzajów 
treści. SmartContrast dynamicznie reguluje kontrast 
i dostosowuje podświetlenie w celu uzyskania 
wyraźnych, czystych, jasnych obrazów podczas gier 
lub oglądania filmów albo wyraźnego, czytelnego 
tekstu przy pracy biurowej. Zmniejszenie zużycia 
energii monitora zapewnia oszczędność pieniędzy 
i wydłużenie żywotności monitora.

	 Jak to działa?
Po uaktywnieniu funkcji SmartContrast, analizuje 
ona wyświetlaną zawartość w czasie rzeczywistym 
w celu dostosowania kolorów i intensywności 
podświetlenia. Funkcja ta dynamicznie poprawia 
kontrast, zapewniając doskonałą jakość podczas 
oglądania video lub podczas gier.
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	 Uruchomienie w oknie Standard 
(Standardowe):

Menu Adjust (Dostosuj):
•	 Menu Adjust (Dostosuj) umożliwia 

dostosowanie ustawień, takich jak 
Brightness (Jasność), Contrast (Kontrast), 
Focus (Ostrość), Position (Położenie) i 
Resolution (Rozdzielczość).

•	 Należy postępować zgodnie z instru kcjami 
i wykonać regulacje.

•	 Anuluj powoduje wyświetlenie pytania o 
anulowanie instalacji.
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Menu Color (Kolor):
•	 Menu Color (Kolor) umożliwia 

dopasowanie ustawień RGB, Black Level 
(Poziom czerni), White Point (Punkt bieli) i 
Color Calibration (Kalibracja kolorów).

•	 Należy postępować zgodnie z instru kcjami 
i wykonać regulacje.

•	 Sprawdź w tabeli poniżej określony 
element podmenu.

•	 Przykład funkcji Color Calibration 
(Kalibracja kolorów):
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1.	 "Show Me" (Pokaż) uruchamia samouczek 
kalibracji kolorów.

2.	 Start - uruchamia 6-krokową sekwencję kalibracji 
kolorów.

3.	 Quick View (Szybki podgląd) umożliwia 
ładowanie obrazów przed/po zmianie.

4.	 Aby powrócić do głównego okna Color (Kolor) 
należy kliknąć przycisk Cancel (Anuluj).

5.	 Funkcja Enable color calibration (Włącz kalibrację 
kolorów) jest włączona domyślnie. Jeśli nie jest 
zaznaczona, uniemożliwia wykonanie kalibracji 
kolorów, a przyciski Start (startu) i Quick View 
(szybkiego podglądu) są wyszarzone.

6.	 Na ekranie kalibracji muszą znajdować się 
informacje patentowe.

Pierwszy ekran kalibracji kolorów:

•	 Przycisk Previous (Poprzedni) jest wyłączony do 
momentu wyświetlenia drugiego ekranu kolorów.

•	 Next (Następny) umożliwia przejście do 
kolejnego ustawienia (6 ustawień).

•	 Z ostatniego ustawienia można przejść do okna 
File>Presets (Plik>Ustawienia wstępne).

•	 Cancel (Anuluj) umożliwia zamknięcie interfejsu 
użytkownika i powrót do strony dodatków plug-
in.

Options>Preferences (Opcje>Preferencje) - Będzie 
aktywne wyłącznie po wybraniu pozycji Preferences 
(Preferencje) z menu rozwijanego Options (Opcje). 
Dla monitorów bez obsługi DDC/CI dostępne są 
wyłącznie zakładki Help (Pomoc) i Options (Opcje).

•	 Wyświetlanie bieżących ustawień preferencji.
•	 Zaznaczone pole wyboru włącza funkcję. Pole 

wyboru jest przełącznikiem.
•	 Domyślnie na pulpicie włączona jest opcja 

Enable Context Menu (Włącz menu 
kontekstowe). Enable Context Menu (Włącz 
menu kontekstowe) daje możliwość wyboru 
SmartControl Lite dla opcji Select Preset 
(Wybierz ustawienia wstępne) i Tune Display 
(Dostosuj ekran), w menu kontekstowym, 
dostępnym po kliknięciu pulpitu prawym 
przyciskiem myszy. Wyłączenie, powoduje 
usunięcie SmartControl Lite z menu 
kontekstowego wyświetlanego po kliknięciu 
prawym przyciskiem myszy.

•	 Domyślnie zaznaczona (Włączona) jest 
ikona Enable Task Tray (Włącz pasek zadań). 
Enable Context Menu (Włączenie menu 
kontekstowego) wyświetla menu paska zadań 
programu SmartControl Lite. Kliknięcie prawym 
przyciskiem myszy ikony paska zadań, powoduje 
wyświetlenie opcji menu Help (Pomoc), Technical 
Support (Pomoc techniczna), Check for Update 
(Sprawdź uaktualnienia), About (Informacje) i 
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Exit (Zakończ). Po wyłączeniu menu paska zadań, 
ikona paska zadań wyświetlać będzie wyłącznie 
opcję EXIT (Zakończ).

•	 Domyślnie zaznaczona jest (Włączona) opcja 
Run at Startup (Włącz przy uruchamianiu 
systemu). Po jej wyłączeniu program 
SmartControl Lite nie będzie uruchamiany przy 
starcie systemu, ani nie będzie pokazywany na 
pasku zadań. Program SmartControl Lite można 
wtedy uruchomić jedynie za pomocą skrótu na 
pulpicie lub poprzez plik programu. Po usunięciu 
zaznaczenia (wyłączeniu) tego pola wyboru, nie 
zostanie załadowane przy starcie żadne wstępne 
ustawienie.

•	 Włączenie trybu przezroczystości (Windows 
7, Vista, XP). Domyślna wartość to 0% 
nieprzezroczystości.

Options>Input (Opcje>Wejście) - Będzie 
aktywne wyłącznie po wybraniu Input (Wejście) 
z menu rozwijanego Options (Opcje). Dla 
monitorów bez obsługi DDC/CI dostępne są 
wyłącznie zakładki Help (Pomoc) i Options 
(Opcje). Wszystkie inne zakładki programu 
SmartControl Lite nie są dostępne.

•	 Wyświetlanie panela instrukcji Source 
(Źródło) i bieżących ustawień źródła 
wejścia.

•	 W monitorach z pojedynczym wejściem 
okno to nie jest wyświetlane.

Options (Opcje)>Audio - Zostanie 
uaktywnione wyłącznie po wybraniu Audio z 
rozwijanego menu Options (Opcje).
Dla monitorów bez obsługi DDC/CI dostępne 
są wyłącznie zakładki Help (Pomoc) i Options 
(Opcje).

Help>User Manual (Pomoc>Podręcznik 
użytkownika) - Będzie aktywne wyłącznie po 
wybraniu User Manual (Podręcznik użytkownika) 
z menu rozwijanego Help (Pomoc). Dla 
monitorów bez obsługi DDC/CI dostępne są 
wyłącznie zakładki Help (Pomoc) i Options 
(Opcje).

Help>Version (Pomoc>Wersja) - Będzie 
aktwyne wyłącznie po wybraniu pozycji Version 
(Wersja) z menu rozwijanego Help (Pomoc). 
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Dla monitorów bez obsługi DDC/CI dostępne 
są wyłącznie zakładki Help (Pomoc) i Options 
(Opcje).

Context Sensitive Menu (Menu kontekstowe)
Context Sensitive Menu (Menu kontekstowe) 
jest domyślnie włączone. Po zaznaczeniu pola 
wyboru Enable Context Menu (Włącz menu 
kontekstowe) w oknie Options>Preferences 
(Opcje>Preferencje) menu to będzie widoczne.

Context Menu (Menu kontekstowe) zawiera 
trzy elementy:
•	 SmartControl Lite - Po wybraniu 

wyświetlane jest okno About (Informacje) 
o ekranie.

•	 Select Preset (Wybierz ustawienia 
wstępne) - Udostępnia hierarchiczne 
menu zapisanych ustawień wstępnych 
do natychmiastowego wykorzystania. 
Znak zaznaczenia wskazuje aktualnie 

wybrane ustawienie wstępne. Za pomocą 
menu rozwijanego można także uzyskać 
dostęp do opcji Factory Preset (Wstępne 
ustawienia fabryczne).

•	 Tune Display (Dostosuj ekran) - Otwiera 
panel sterowania SmartControl Lite.

Włączone menu paska zadań
Menu paska zadań można wyświetlić po 
kliknięciu prawym przyciskiem myszy ikony 
SmartControl Lite na pasku zadań. Kliknięcie 
lewym przyciskiem myszy spowoduje 
uruchomienie aplikacji.

Menu paska zadań zawiera pięć elementów:
•	 Help (Pomoc) - Dostęp do pliku User 

Manual (podręcznika użytkownika): Otwiera 
plik User Manual (podręcznika użytkownika) 
w oknie domyślnej przeglądarki.

•	 Technical Support (Pomoc techniczna) - 
wyświetla stronę pomocy technicznej.

•	 Check for Update (Sprawdź aktualizacje) 
- przenosi użytkownika na stronę PDI 
Landing i sprawdza wersję użytkownika 
w odniesieniu do najbardziej aktualnej, 
dostępnej wersji.

•	 About (Informacje) - Wyświetla 
szczegółowe informacje o produkcie: wersja 
produktu, informacje o wydaniu i nazwa 
produktu.

•	 Exit (Zakończ) - Zamknięcie programu 
SmartControl Lite.

W celu ponownego uruchomienia 
SmartControl Lite, wybierz SmartControl 
Lite z menu Program, kliknij dwukrotnie ikonę 
komputera desktop PC lub uruchom ponownie 
system.
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Wyłączone menu paska zadań
Po wyłączeniu paska zadań w folderze preferencji 
dostępna jest tylko opcja EXIT (Zakończ). Aby 
całkowicie usunąć program SmartControl Lite z 
paska zadań, należy wyłączyć ustawienie Run at 
Startup (Włącz przy uruchamianiu systemu) w 
Options>Preferences (Opcje>Preferencje).

	 Uwaga
Wszystkie ilustracje z tej części służą wyłącznie 
jako odniesienie. Wersja oprogramowania 
SmartControl, może zostać zmieniona bez 
powiadomienia. Należy regularnie sprawdzać 
oficjalną witrynę Portrait pod adresem www.
portrait.com/dtune/phl/enu/index w celu 
pobrania najnowszej wersji oprogramowania 
SmartControl.

www.portrait.com/dtune/phl/enu/index
www.portrait.com/dtune/phl/enu/index
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4.	 Dane techniczne
Obraz/ekran
Typ panela monitora TFT-LCD
Podświetlenie LED
Rozmiar panela 24'' W (61 cm)
Współczynnik proporcji 16:9
Podziałka pikseli 0,277 × 0,277 mm
Jasność 250 cd/m²
SmartContrast 10.000.000:1
Współczynnik kontrastu 
(typ.) 1000:1

Czas odpowiedzi (typ.) 5ms
Optymalna rozdzielczość 1920 × 1080 @ 60Hz
Kąt widzenia 170° (w poziomie)/160° (w pionie) @ C/R > 10
Kolory wyświetlacza 16,7 M
Częstotliwość odświeżania w 
pionie 56Hz - 76Hz

Częstotliwość pozioma 30kHz - 83kHz
sRGB TAK
Możliwości podłączeń
Wejście sygnału DVI (cyfrowe), VGA (analogowe), HDMI (opcjonalne)
Sygnał wejścia Separate Sync, Sync on Green
Wejście/wyjście audio Wejście audio PC, wyjście słuchawek(246V5LHAB/246V5LAB)
Udogodnienia
Wbudowane głośniki 2W × 2 (246V5LHAB/246V5LAB)

Udogodnienia użytkownika

246V5LSB:  
246V5LAB:  

246V5LHAB:  

Języki OSD

Angielski, Francuski, Niemiecki, Hiszpański, Włoski, Rosyjski,
chiński uproszczony, portugalski, turecki, holenderski, szwedzki, fiński, 
polski, czeski, koreański, japoński, węgierski, ukraiński, portugalski 
brazylijski, grecki (opcjonalnie), chiński tradycyjny (opcjonalnie) 

Inne udogodnienia Blokada Kensington
Zgodność ze standardem 
Plug and Play DDC/CI, sRGB, Windows 8/7/Vista/XP, Mac OSX, Linux

Podstawa
Nachylanie -5 / +20

246V5LHAB
Zasilanie
Tryb włączenia 25,61 W (typ.), 32,88 W (maks.),
Sleep (Uśpienie) 
(Oczekiwanie) 0,5W

Wył. 0,3W
Wskaźnik LED zasilania Tryb włączenia: Białe, tryb gotowości/uśpienia: Białe (migające)
Zasilacz Wbudowany, prąd zmienny 100-240V, 50-60Hz
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246V5LAB/246V5LSB

Zasilanie

Tryb włączenia

246V5LAB:
26,21 W (typ.), 33,41 W (maks.),
246V5LSB:
24,6 W (typ.), 26,45 W (maks.),

Sleep (Uśpienie) (Oczekiwanie) 0,5W
Wył. 0,3W
Wskaźnik LED zasilania Tryb włączenia: Białe, tryb gotowości/uśpienia: Białe (migające)
Zasilacz Wbudowany, prąd zmienny 100-240V, 50-60Hz

Wymiary
Produkt z podstawą (S x W x G) 565× 435 × 238 mm
Produkt bez podstawy 
(S x W x G) 565 × 354 × 63 mm

Ciężar
Produkt z podstawą 4,65kg
Produkt bez podstawy 4,22kg
Produkt z opakowaniem 6,14kg
Warunki pracy
Zakres temperatury (działanie) 0ºC do 40ºC
Zakres temperatury
(Brak działania) -20ºC do 60ºC

Wilgotność względna 20% do 80%
MTBF 30.000 godz.
Środowiskowe
ROHS TAK
EPEAT(Przepisy mogą różnić się 
zależnie od kraju) Silver (www.epeat.net)

Opakowanie W 100% nadające się do przetworzenia
Specyficzne substancje Obudowa w 100% z PCV, bez BFR
Energy Star(Przepisy mogą 
różnić się zależnie od kraju) TAK

Zgodność i standardy

Certyfikaty Znak CE, FCC klasa B, GOST, SEMKO, TCO Certified, ETL 
ISO9241-307, BSMI

Obudowa
Kolor Czarny
Wykończenie Z połyskiem/Tekstura 

	 Uwaga
1.	 Certyfikat EPEAT Gold lub Silver jest ważny wyłącznie po zarejestrowaniu produktu przez Philips. 

Informacje o stanie rejestracji w danym kraju, można uzyskać pod adresem www.epeat.net.
2.	 Dane te mogą zostać zmienione bez powiadomienia. Przejdź do www.philips.com/support w celu 

pobrania najnowszej wersji ulotki.

www.epeat.net
www.philips.com/support
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4.1	 Rozdzielczość i tryby ustawień 
wstępnych

	 Maksymalna rozdzielczość
1920 x 1080 @ 60 Hz (wejście analogowe)
1920 x 1080 @ 60 Hz (wejście cyfrowe)

	 Zalecana rozdzielczość
1920 x 1080 @ 60 Hz (wejście cyfrowe)

Częst. poz. 
(kHz)

Rozdzielczość Częst. pion. 
(Hz)

31,47 720 × 400 70,09
31,47 640 × 480 59,94
35,00 640 × 480 66,67
37,86 640 × 480 72,81
37,50 640 × 480 75,00
37,88 800 × 600 60,32
46,88 800 × 600 75,00
48,36 1024 × 768 60,00
60,02 1024 × 768 75,03
44,77 1280 × 720 59,86
63,89 1280 × 1024 60,02
79,98 1280 × 1024 75,03
55,94 1440 × 900 59,89
70,64 1440 × 900 74,98
65,29 1680 × 1050 59,95
67,50 1920 × 1080 60,00

	 Uwaga
Należy pamiętać, że wyświetlacz działa najlepiej 
w oryginalnej rozdzielczości 1920 x 1080 @ 
60Hz. Przestrzeganie tego zalecenia pozwala 
uzyskać najlepszą jakość obrazu.
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5.	 Zarządzanie zasilaniem
Jeśli karta graficzna obsługuje standard VESA 
DPM lub jeśli zainstalowano w komputerze 
odpowiednie oprogramowanie, monitor może 
automatycznie zmniejszać zużycie energii, gdy 
nie jest używany. Po wykryciu sygnału wejścia 
z klawiatury, myszy lub innego urządzenia 
wejścia, praca monitora zostanie automatycznie 
“wznowiona”. W tabeli poniżej przedstawiono 
zużycie energii i sygnalizowanie funkcji 
automatycznego oszczędzania energii:

246V5LSB:
Definicja zarządzania zasilaniem

Tryb VESA Wideo Synch. 
poz.

Synch. 
pion.

Zużyta 
energia

Kolor 
wskaźnika 

LED

Aktywny Wł. Tak Tak

24,6 W 
(typ.)

26,45 W 
(maks.)

Biały

Uśpienie 
(Oczekiwanie) Wył. Nie Nie  < 0,5W 

(typ.)
Biały 

(migający) 

Wyłączony Wył. - -  < 0,3W 
(typ.) Wył.

246V5LAB:
Definicja zarządzania zasilaniem

Tryb VESA Wideo Synch. 
poz.

Synch. 
pion.

Zużyta 
energia

Kolor 
wskaźnika 

LED

Aktywny Wł. Tak Tak

26,21W 
(typ.)

33,41 W 
(maks.)

Biały

Uśpienie 
(Oczekiwanie) Wył. Nie Nie < 0,5W 

(typ.)
Biały 

(migający)

Wyłączony Wył. - -  < 0,3W 
(typ.) Wył.

246V5LHAB:
Definicja zarządzania zasilaniem

Tryb VESA Wideo Synch. 
poz.

Synch. 
pion.

Zużyta 
energia

Kolor 
wskaźnika 

LED

Aktywny Wł. Tak Tak

25,61 W 
(typ.)

32,88 W 
(maks.)

Biały

Uśpienie 
(Oczekiwanie) Wył. Nie Nie < 0,5W 

(typ.)
Biały 

(migający)

Wyłączony Wył. - -  < 0,3W 
(typ.) Wył.

W celu pomiaru zużycia energii tego monitora 
należy wykonać następujące ustawienia.

•	 Oryginalna rozdzielczość: 1920 × 1080
•	 Kontrast: 50%
•	 Jasność: 250 nitów lub 200 nitów
•	 Temperatura barwowa: 6500k z pełnym 

wzorcem bieli

	 Uwaga
Dane te mogą zostać zmienione bez 
powiadomienia.



20

6. Informacje o przepisach

6.	 Informacje o przepisach
The regulations may differ depending on your 
country

Lead-free Product

Lead free display promotes environmentally 
sound recovery and disposal of waste from 
electrical and electronic equipment. Toxic 
substances like Lead has been eliminated 
and compliance with European community’s 
stringent RoHs directive mandating restrictions 
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

Congratulations!

This product is TCO Certified-for Sustainable IT

TCO Certified is an international third party 
sustainability certification for IT 
products. TCO Certified ensures that 
the manufacture, use and recycling 

of IT products reflect environmental, social and 
economic responsibility.  Every TCO Certified 
product model is verified by an accredited 
independent test laboratory. ​ 
This product has been verified to meet all the 
criteria in TCO Certified, including:

Corporate Social Responsibility 
Socially responsible production - working 
conditions and labor law in manufacturing 
country

Energy Efficiency 
Energy efficiency of product and power supply. 
Energy Star compliant, where applicable 

Environmental Management System 
Manufacturer must be certified according to 
either ISO 14001 or EMAS

Minimization of Hazardous Substances 
Limits on cadmium, mercury, lead & hexavalent 
chromium including requirements for mercury-
free products, halogenated substances and 
hazardous flame retardants

Design for Recycling 
Coding of plastics for easy recycling. Limit on 
the number of different plastics used.

Product Lifetime, Product Take Back 
Minimum one-year product warranty. Minimum 
three-year availability of spare parts. Product 
takeback 

Packaging 
Limits on hazardous substances in product 
packaging. Packaging prepared for recycling

Ergonomic, User-centered design 
Visual ergonomics in products with a display. 
Adjustability for user comfort (displays, 
headsets)  Acoustic performance – protection 
against sound spikes (headsets) and fan noise 
(projectors, computers) Ergonomically designed 
keyboard (notebooks)

Electrical Safety, minimal electro-magnetic 
Emissions  Third Party Testing  
All certified product models have been tested 
in an independent, accredited laboratory.

A detailed criteria set is available for download 
at www.tcodevelopment.com, where you can 
also find a searchable database of all TCO 
Certified IT products.

TCO Development, the organization behind 
TCO Certified, has been an international 
driver in the field of Sustainable IT for 20 years. 
Criteria in TCO Certified are developed in 
collaboration with scientists, experts, users 
and manufacturers. Organizations around 
the world rely on TCO Certified as a tool to 
help them reach their sustainable IT goals. We 
are owned by TCO, a non-profit organization 
representing office workers. TCO Development 
is headquartered in Stockholm, Sweden, with 
regional presence in North America and Asia.

TCO Certified Document for Displays version. 
2.3.

"For displays with glossy bezels the user should 
consider the placement of the display as the 
bezel may cause disturbing reflections from 
surrounding light and bright surfaces."
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For more information, please visit  
www.tcodevelopment.com

Technology for you and the planet

(Only for selective models)

EPEAT

(www.epeat.net)

The EPEAT (Electronic 
Product Environmental 
Assessment Tool) program 
evaluates computer 

desktops, laptops, and monitors based on 51 
environmental criteria developed through 
an extensive stakeholder consensus process 
supported by US EPA.

EPEAT system helps purchasers in the public 
and private sectors evaluate, compare and 
select desktop computers, notebooks and 
monitors based on their environmental 
attributes. EPEAT also provides a clear and 
consistent set of performance criteria for the 
design of products, and provides an opportunity 
for manufacturers to secure market recognition 
for efforts to reduce the environmental impact 
of its products.

Benefits of EPEAT

Reduce use of primary materials 
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S 
requirement that all registered products meet 
ENERGY STAR’s energy efficiency specifications, 
means that these products will consume less 
energy throughout their life.

CE Declaration of Conformity

This product is in conformity with the following 
standards 

•	 EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of 
Information Technology Equipment).

•	 EN55022:2010 (Radio Disturbance 
requirement of Information Technology 
Equipment).

•	 EN55024:2010 (Immunity requirement of 
Information Technology Equipment).

•	 EN61000-3-2:2006 +A1:2009+A2:2009 
(Limits for Harmonic Current Emission).

•	 EN61000-3-3:2008 (Limitation of Voltage 
Fluctuation and Flicker) following provisions 
of directives applicable.

•	 2006/95/EC (Low Voltage Directive).

•	 2004/108/EC (EMC Directive).

•	 2009/125/EC (ErP, Energy-related Product 
Directive, EC No. 1275/2008 and 642/2009 
Implementing) 

•	 2011/65/EU (RoHS Directive)

And is produced by a manufacturing 
organization on ISO9000 level.

The product also comply with the following 
standards 

•	 ISO9241-307:2008 (Ergonomic 
requirement, Analysis and compliance test 
methods for electronic visual displays).

•	 GS EK1-2000:2013 (GS mark requirement).

•	 prEN50279:1998 (Low Frequency Electric 
and Magnetic fields for Visual Display).

•	 MPR-II (MPR:1990:8/1990:10 Low 
Frequency Electric and Magnetic fields).

•	 TCO CERTIFIED (Requirement for 
Environment Labeling of Ergonomics, 
Energy, Ecology and Emission, TCO: Swedish 
Confederation of Professional Employees) 
for TCO versions.
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Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we 
have determined that this product 
meets the ENERGY STAR® 
guidelines for energy efficiency.

	 Note
We recommend you switch off the monitor 
when it is not in use for a long time.

Federal Communications Commission (FCC) 
Notice (U.S. Only)

	 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
Rules. These limits are designed to provide 
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  
 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

•	 Reorient or relocate the receiving antenna.

•	 Increase the separation between the 
equipment and receiver.

•	 Connect the equipment into an outlet on 
a circuit different from that to which the 
receiver is connected.

•	 Consult the dealer or an experienced 
radio/TV technician for help.

	 Changes or modifications not expressly 
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

Use only RF shielded cable that was supplied 
with the monitor when connecting this monitor 
to a computer device. 

To prevent damage which may result in fire or 
shock hazard, do not expose this appliance to 
rain or excessive moisture. 

THIS CLASS B DIGITAL APPARATUS MEETS 
ALL REQUIREMENTS OF THE CANADIAN 
INTERFERENCE-CAUSING EQUIPMENT 
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 

Commission Federale de la Communication 
(FCC Declaration)

	 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de 
l'article 15 Des règles de la FCC. Ces 
limites sont conçues de façon à fourir 
une  protection raisonnable contre les 
interférences nuisibles dans le cadre d'une 
installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  
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Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

•	 Réorienter ou déplacer l’antenne de 
réception.

•	 Augmenter la distance entre l’équipement 
et le récepteur.

•	 Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.

•	 Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.

	 Toutes modifications n'ayant pas reçu 
l'approbation des services compétents 
en matière de conformité est susceptible 
d'interdire à l'utilisateur l'usage du présent 
équipement.

N'utiliser que des câbles RF armés pour 
les connections avec des ordinateurs ou 
périphériques. 

CET APPAREIL NUMERIQUE DE LA CLASSE 
B RESPECTE TOUTES LES EXIGENCES DU 
REGLEMENT SUR LE MATERIEL BROUILLEUR 
DU CANADA. 

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification 
Notice

The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.

A protection mark "B" confirms that the 
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
and PN-89/E-06251.
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACERINGEN FOR, AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
Schäden durch Röntgenstrahlen" festgelegten 
Vorschriften. 

Auf der Rückwand des Gerätes befindet sich 
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
über die Bauart von Störstrahlern nach Anlage 
III ¤ 5 Abs. 4 der Röntgenverordnung erfüllt sind. 

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 

1.	 Reparaturen nur durch Fachpersonal 
durchgeführt werden. 

2.	 	nur original-Ersatzteile verwendet werden. 

3.	 	bei Ersatz der Bildröhre nur eine 
bauartgleiche eingebaut wird. 

Au s  e r gonom i s c h en  G ründen  w i r d 
empfohlen, die Grundfarben Blau und 
Rot nicht auf dunklem Untergrund zu 
verwenden (schlechte Lesbar keit  und 
erhöhte Augenbelastung bei zu geringem 
Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

	 ACHTUNG: BEIM AUFSTELLEN 
DIESES GERÄTES DARAUF 
ACHTEN, DAß NETZSTECKER UND 
NETZKABELANSCHLUß LEICHT 
ZUGÄNGLICH SIND. 
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China RoHS 

The People's Republic of China released a 
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
RoHS. All products including CRT and Monitor 
which are produced and sold for China market 
have to meet China RoHS request.

 环保使用期限 

此标识指期限 ( 十年 ), 电子信息产品中含有的有毒有害

物质或元素在正常使用的条件下不会发生外泄或突变 , 

电子信息产品用户使用该电子信息产品不会对环境造成

严重污染或对其人身、 财产造成严重损害的期限．

中国能源效率标识
根据中国大陆《能源效率标识管理办法》，本显示器符合以下要求：

详细有关信息请查阅中国能效标识网：http://www.energylabel.gov.cn/

关闭状态能耗（W)
能源效率(cd/W)

< 0.5
> 1.05

1级
GB 21520-2008

能效等级
能效标准

《废弃电器电子产品回收处理管理条例》提示性
说明

为了更好地关爱及保护地球，当用户不再需要此产品或
产品寿命终止时，请遵守国家废弃电器电子产品回收处
理相关法律法规，将其交给当地具有国家认可的回收处
理资质的厂商进行回收处理。  

EU Energy Label

The European Energy Label informs you on 
the energy efficiency class of this product. 
The greener the energy efficiency class of this 
product is the lower the energy it consumes. 

On the label, you can find the energy efficiency 
class, the average power consumption of 
this product in use and the average energy 
consumption for 1 year. 

	 Note

The EU Energy Label will be ONLY applied on 
the models bundling with HDMI and TV tuners.
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7.	 Obsługa klienta i 
gwarancja

7.1	 Zasady firmy Philips dotyczące 
defektu pikseli monitorów z 
płaskim panelem

Firma Philips stara się dostarczać najwyższej jakości 
produkty. Wykorzystujemy niektóre najbardziej 
zaawansowane, przemysłowe procesy produkcji 
i surową kontrolę jakości. Mimo to czasami nie 
można uniknąć defektów pikseli lub subpikseli 
paneli TFT monitorów, stosowanych w monitorach 
z płaskim panelem. Żaden producent nie może 
zagwarantować, wykluczenia defektu pikseli 
ze wszystkich paneli, firma Philips gwarantuje 
natomiast, że każdy monitor w którym stwierdzi 
się niedopuszczalną ilość defektów, zostanie 
naprawiony lub wymieniony w ramach gwarancji. 
Niniejsza informacja objaśnia różne rodzaje defektu 
pikseli i definiuje dopuszczalną ilość defektów dla 
każdego ich rodzaju. Aby panel TFT monitora został 
zakwalifikowany do naprawy lub wymiany w ramach 
gwarancji, ilość występujących w nim defektów 
pikseli musi przekraczać dopuszczalne normy. Na 
przykład, nie może być uszkodzonych więcej niż 
0,0004% podpikseli monitora. Poza tym, ponieważ 
niektóre rodzaje lub kombinacje defektów pikseli są 
zdecydowanie bardziej zauważalne, Philips ustanawia 
dla nich jeszcze wyższe normy jakościowe. Zasada ta 
obowiązuje na całym świecie.

podpiksel podpiksel podpiksel

piksel

Piksele i subpiksele
Piksel lub inaczej element obrazu, składa się z trzech 
subpikseli w kolorach podstawowych: czerwonym, 
zielonym i niebieskim. Wiele pikseli tworzy razem 
obraz. Gdy świecą wszystkie subpiksele danego 
piksela, trzy kolorowe subpiksele wyglądają jak 
pojedynczy biały piksel. Kiedy wszystkie subpiksele 
są ciemne, trzy kolorowe subpiksele wyglądają 

jak pojedynczy czarny piksel. Inne kombinacje 
świecących i ciemnych subpikseli wyglądają jak 
pojedyncze piksele o analogicznych kolorach.

Rodzaje defektów pikseli
Defekty pikseli i subpikseli objawiają się na ekranie 
w różny sposób. Istnieją dwie kategorie defektów 
pikseli, a każda z nich obejmuje kilka rodzajów 
defektów subpikseli.

Defekty jasnych plamek
Defekty jasnych plamek objawiają się w taki sposób, 
jakby piksele lub subpiksele stale świeciły lub były 
“włączone”. Jasna plamka to subpiksel widoczny na 
ekranie, gdy monitor wyświetla ciemny wzór. Można 
wyróżnić następujące typy defektów jasnych plamek.

Jeden świecący czerwony, zielony lub niebieski 
subpiksel.

Dwa sąsiednie świecące subpiksele:
-	 Czerwony + niebieski = purpurowy
-	 Czerwony + zielony = żółty
-	 Zielony + niebieski = błękitny (jasnoniebieski)

Trzy sąsiednie świecące subpiksele  
(jeden biały piksel).
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	 Uwaga
Czerwona lub niebieska jasna plamka jest jaśniejsza 
o więcej niż 50 procent od sąsiednich plamek, a 
zielona jasna plamka jest o 30 procent jaśniejsza od 
sąsiednich plamek.

Defekty czarnych plamek
Defekty czarnych plamek objawiają się w taki 
sposób, jakby piksele lub subpiksele stale były ciemne 
lub “wyłączone”. Ciemna plamka to widoczny na 
ekranie subpiksel, gdy monitor wyświetla jasny 
wzór. Można wyróżnić następujące typy defektów 
czarnych plamek.

Bliskość defektów pikseli
Ponieważ mogą być bardziej zauważalne defekty 
pikseli i subpikseli tego samego rodzaju, znajdujące 
się niedaleko siebie, firma Philips określa również 
tolerancje bliskości defektów pikseli.

Tolerancje defektu pikseli
Aby panel TFT monitora został zakwalifikowany w 
okresie gwarancyjnym do naprawy lub wymiany z 
powodu defektów pikseli, muszą w nim wystąpić 
defekty pikseli przekraczające tolerancje podane w 
poniższych tabelach.

DEFEKTY JASNYCH PLAMEK DOPUSZCZALNY POZIOM
1 świecący subpiksel 3

2 sąsiednie świecące subpiksele 1

3 sąsiednie świecące subpiksele (jeden biały) 0

Odległość pomiędzy dwoma defektami jasnej plamki* >15mm

Łączna liczba defektów jasnych plamek wszystkich rodzajów 3

DEFEKTY CZARNYCH PLAMEK DOPUSZCZALNY POZIOM
1 ciemny subpiksel 5 lub mniej

2 sąsiadujące ciemne subpiksele 2 lub mniej

3 sąsiadujące ciemne subpiksele 0

Odległość pomiędzy defektami dwóch czarnych plamek* >15mm

Łączna liczba defektów ciemnych plamek wszystkich rodzajów 5 lub mniej

ŁĄCZNA LICZBA DEFEKTÓW PLAMEK DOPUSZCZALNY POZIOM
Łączna liczba defektów jasnych i ciemnych plamek wszystkich rodzajów 5 lub mniej

	 Uwaga
1.	 Defekty 1 lub 2 sąsiadujących subpikseli = 1 defekt plamki
2.	 Ten monitor jest zgodny ze standardem ISO9241-307. Zgodność z klasą I. (ISO9241-307: Wymagania 

dotyczące ergonomii, metody testów zgodności i analizy dla elektronicznych wyświetlaczy wizualnych)
3.	 Standard ISO9241-307 jest następcą znanego wcześniej standardu ISO13406, który został wycofany przez 

Międzynarodową Organizację Normalizacyjną (ISO) dnia: 2008-11-13.
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7.2	 Serwis i gwarancja
Szczegółowe informacje dotyczące zakresu działania gwarancji i dodatkowego wsparcia w danym 
regionie, można uzyskać na stronie sieci web, pod adresem www.philips.com/support. Kontaktować się 
można także pod podanym poniżej lokalnym numerem obsługi klienta Philips.

Informacje kontaktowe dla regionu Europy Zachodniej:
Kraj ASC Numer obsługi klienta Cena
Germany Siemens I&S +49 01803 386 853 € 0,09

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff

Ireland Invec Scotland +353 01 601 1161 Local call tariff

Spain Eatsa Spain +34 902 888 785 € 0,10

Finland A-novo +358 09 2290 1908 Local call tariff

France A-novo +33 082161 1658 € 0,09

Greece Allman Hellas +30 00800 3122 1223 Free of charge

Italy A-novo +39 840 320 041 € 0,08

Netherlands E Care +31 0900 0400 063 € 0,10

Denmark A-novo +45 3525 8761 Local call tariff

Norway A-novo +47 2270 8250 Local call tariff

Sweden A-novo +46 08 632 0016 Local call tariff

Poland Zolter +48 0223491505 Local call tariff

Austria Siemens I&S +43 0810 000206 € 0,07

Belgium E Care +32 078 250851 € 0,06

Luxembourg E Care +352 26 84 30 00 Local call tariff

Portugal Eatsa Spain +351 2 1359 1440 Local call tariff

Switzerland A-novo +41 02 2310 2116 Local call tariff

www.philips.com/support
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Informacje kontaktowe dla EUROPY CENTRALNEJ I WSCHODNIEJ:

Kraj Centrum obsługi 
telefonicznej ASC Numer obsługi klienta

Belarus NA IBA +375 17 217 3386

Bulgaria NA LAN Service +359 2 960 2360

Croatia NA Renoprom +385 1 333 0974

Estonia NA FUJITSU +372 6519900

Latvia NA “ServiceNet LV” Ltd. +371 7460399

Lithuania NA UAB “Servicenet” +370 7400088

Romania NA Blue Ridge Intl. +40 21 2101969

Serbia & 
Montenegro

NA Kim Tec d.o.o. +381 11 20 70 684

Slovenia NA PC H.and +386 1 530 08 24

Ukraine
NA Comel +380 562320045

NA Topaz-Service Company +38 044 245 73 31

Russia
NA CPS +7 (495) 645 6746 (for repair)

NA CEEE Partners +7 (495) 645 3010 (for sales)

Slovakia NA Datalan Service +421 2 49207155

Turkey NA Techpro +90 212 444 4 832

Czech Rep. NA Asupport 800 100 697

Hungary
NA Serware +36 1 2426331

NA Profi Service +36 1 814 8080

Informacje kontaktowe dla AMERYKI ŁACIŃSKIEJ:
Kraj Centrum obsługi telefonicznej Numer obsługi klienta
Brazil

Vermont
0800-7254101

Argentina 0800 3330 856

Informacje kontaktowe dla Chiny:
China
Numer obsługi klienta : 4008 800 008

Informacje kontaktowe dla AMERYKI PÓŁNOCNEJ:

Kraj Centrum obsługi 
telefonicznej ASC Numer obsługi klienta

U.S.A. EPI-e-center Qwantech (877) 835-1838

Canada Supercom Supercom (800) 479-6696
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Informacje kontaktowe dla regionu APMEA:

Kraj Centrum obsługi 
telefonicznej ASC Numer obsługi klienta

Australia NA
AGOS NETWORK PTY 
LTD

1300 360 386

New Zealand NA Visual Group Ltd. 0800 657447

Hong Kong / 
Macau

NA Smart Pixels Technology Ltd.
Hong Kong:Tel: +852 2619 9639
Macau:Tel: (853)-0800-987

India NA REDINGTON INDIA LTD
Tel: 1 800 425 6396
SMS: PHILIPS to 56677

Indonesia NA
PT. Gadingsari elektronika 
Prima

Tel: 62 21 75909053, 75909056, 
7511530

South Korea NA PCS One Korea Ltd. 080-600-6600

Malaysia NA
After Market Solutions (CE) 
Sdn Bhd

603 7953 3370

Pakistan NA Philips Consumer Service (9221) 2737411-16

Singapore NA
Philips Electronics Singapore 
Pte Ltd (Philips Consumer 
Care Center)

(65) 6882 3999

Taiwan
PCCW 
Teleservices 
Taiwan

FETEC.CO 0800-231-099

Thailand NA
Axis Computer System Co., 
Ltd.

(662) 934-5498

South Africa NA Sylvara Technologies Pty Ltd 086 0000 888

United Arab 
Emirates

NA
AL SHAHD COMPUTER 
L.L.C

00971 4 2276525

Israel NA Eastronics LTD 1-800-567000

Vietnam NA
FPT Service Informatic 
Company Ltd.

+84 8 38248007 Ho Chi Minh City
+84 5113.562666 Danang City
+84 5113.562666 Can tho Province

Philippines NA Glee Electronics, Inc.
(02) 633-4533 to 34,
(02) 637-6559 to 60

Sri Lanka NA
no distributor and/or service 
provider currently

Bangladesh NA
Distributor: Computer 
Source Ltd (warranty buy-
out)

880-2-9141747, 9127592
880-2-8128848 / 52

Nepal NA
Distributor: Syakar Co. Ltd 
(warranty buy-out)

977-1-4222395

Cambodia NA
Distributor: Neat Technology 
Pte Ltd (Singapore) 
(warranty buy-out)

855-023-999992
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8.	 Rozwiązywanie 
problemów i FAQ

8.1	 Rozwiązywanie problemów
Na stronie tej omówiono problemy, które może 
naprawić użytkownik. Jeśli problem utrzymuje się po 
wypróbowaniu przedstawionych rozwiązań, należy 
skontaktować się z przedstawicielem działu obsługi 
klienta firmy Philips.

	 Typowe problemy
Brak obrazu (nie świeci dioda LED zasilania)
•	 Upewnij się, że przewód zasilający jest 

podłączony do gniazdka elektrycznego, a jego 
drugi koniec do złącza z tyłu monitora.

•	 Upewnij się najpierw, że przycisk zasilania na 
panelu przednim monitora znajduje się w pozycji 
wyłączenia, a następnie naciśnij go do pozycji 
włączenia.

Brak obrazu (Biały kolor diody LED zasilania)
•	 Upewnij się, że komputer jest włączony.
•	 Upewnij się, że kabel sygnałowy jest prawidłowo 

podłączony do komputera.
•	 Upewnij się, że nie są wygięte szpilki złącza kabla 

monitora od strony złącza. Jeśli tak, napraw lub 
wymień kabel.

•	 Może być aktywna funkcja oszczędzania energii.

Na ekranie pojawi się komunikat

Attention

Check cable connection

•	 Upewnij się, że kabel monitora jest prawidłowo 
podłączony do komputera. (Odnosi się także do 
Instrukcji szybkiego uruchomienia).

•	 Sprawdź, czy nie są wygięte szpilki złącza kabla 
monitora.

•	 Upewnij się, że komputer jest włączony.

Nie działa przycisk AUTO
•	 Funkcja ustawień automatycznych jest dostępna 

tylko w VGA-Analog (analogowym trybie VGA). 
Jeśli wynik nie będzie satysfakcjonujący należy 
wykonać regulacje ręcznie, przez menu OSD.

	 Uwaga
Funkcja Auto nie ma zastosowania w trybie DVI-
Digital (cyfrowym DVI), ponieważ nie jest tam 
potrzebna.

Widoczne znaki dymu lub iskrzenia
•	 Nie należy wykonywać żadnych czynności 

rozwiązywania problemów
•	 Dla bezpieczeństwa należy natychmiast odłączyć 

monitor od zasilania sieciowego
•	 Należy jak najszybciej skontaktować się z 

przedstawicielem obsługi klienta Philips.

	 Problemy związane z obrazem

Obraz nie jest wyśrodkowany
•	 Należy wyregulować pozycję obrazu, poprzez 

funkcję "Auto" w głównym menu OSD.
•	 Należy wyregulować pozycję obrazu poprzez 

funkcję Phase/Clock (Faza/Zegar) w menu Setup 
(Ustawienia) głównego menu OSD. Dotyczy to 
wyłącznie trybu VGA.

Drżenie obrazu na ekranie
•	 Należy sprawdzić, czy kabel sygnałowy jest 

prawidłowo i pewnie podłączony do karty 
graficznej lub do komputera PC.

Pojawia się pionowe miganie

•	 Należy wyregulować obraz, poprzez funkcję 
"Auto" w głównym menu OSD.

•	 Należy usunąć pionowe pasy poprzez funkcję 
Phase/Clock (Faza/Zegar) w menu Setup 
(Ustawienia) głównego menu OSD. Dotyczy to 
wyłącznie trybu VGA.

Pojawia się poziome miganie

•	 Należy wyregulować obraz, poprzez funkcję 
"Auto" w głównym menu OSD.

•	 Należy usunąć pionowe pasy poprzez funkcję 
Phase/Clock (Faza/Zegar) w menu Setup 
(Ustawienia) głównego menu OSD. Dotyczy to 
wyłącznie trybu VGA.
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Obraz jest rozmyty, nieostry lub zbyt ciemny
•	 Należy wyregulować kontrast i jasność 

poprzez menu ekranowe.
Po wyłączeniu zasilania na ekranie pozostaje 
"powidok", "wypalenie" obrazu lub "poobraz".
•	 Wydłużone nieprzerwane wyświetlanie 

stałych lub nieruchomych obrazów, może 
spowodować na ekranie "wypalenie", znane 
również jako "powidok" lub "poobraz". 
"Wypalenie", "poobraz" lub "powidok" to 
dobrze znane zjawisko dotyczące technologii 
LCD. W większości przypadków, "wypalenie" 
lub "powidok" albo "poobraz" znika stopniowo 
po pewnym czasie od wyłączenia zasilania.

•	 Po pozostawieniu monitora bez nadzoru 
należy zawsze uaktywniać program 
wygaszacza ekranu z ruchomym obrazem.

•	 Jeśli na ekranie monitora LCD wyświetlane 
są niezmieniające się treści należy zawsze 
uruchamiać aplikację okresowo odświeżającą 
ekran.

•	 W poważniejszych przypadkach "wypalenia" 
lub "powidoku" albo "poobrazu" obrazy 
nie znikają i nie można tego naprawić. 
Wspomniane uszkodzenie nie podlega 
gwarancji.

Obraz jest zniekształcony. Tekst jest niewyraźny 
lub rozmyty
•	 Ustaw tryb rozdzielczości wyświetlania 

komputera PC zgodnie z zalecaną oryginalną 
rozdzielczością ekranu monitora.

Na ekranie pojawiają się zielone, czerwone, 
niebieskie, ciemne i białe punkty
•	 Utrzymujące się punkty to normalna cecha 

ciekłych kryształów, wykorzystywanych 
we współczesnych rozwiązaniach 
technologicznych. Szczegółowe informacje 
znajdują się w części dotyczącej zasad 
postępowania z uszkodzeniami pikseli.

Za silne, przeszkadzające światło "włączenia 
zasilania"
•	 Światło diody „włączonego zasilania” można 

dostosować za pomocą ustawień diody LED 
zasilania w menu Setup (Ustawienia) menu 
głównego OSD.

W celu uzyskania dalszej pomocy należy sprawdzić 
listę Punkty informacji klienta i skontaktować się z 
przedstawicielem działu obsługi klienta firmy Philips.

8.2	 Ogólne pytania FAQ
P1:	 Co należy zrobić, jeśli podczas instalacji 

monitora na ekranie pojawia się komunikat 
„Cannot display this video mode” (Nie 
można wyświetlić tego trybu wideo)?

Odp.:	Zalecana rozdzielczość dla tego monitora: 
1920 x 1080 @ 60 Hz.

•	 Odłącz wszystkie kable, a następnie podłącz 
komputer do uprzednio używanego monitora.

•	 W menu Start systemu Windows wybierz 
kolejno polecenia Settings/Control Panel 
(Ustawienia/Panel sterowania). W oknie Panel 
sterowania wybierz ikonę Display (Ekran). W 
panelu sterowania Display (ekranu) wybierz 
kartę „Settings” (Ustawienia). W zakładce 
ustawień, w polu “Desktop Area” (obszar 
pulpitu) przesuń suwak na 1920 x 1080 pikseli.

•	 Otwórz okno "Advanced Properties 
(Właściwości zaawansowane)" i ustaw dla 
Refresh Rate (Częstotliwość odświeżania) 60 
Hz, a następnie kliknij OK.

•	 Uruchom ponownie komputer oraz powtórz 
czynności 2 i 3 w celu sprawdzenia, czy 
rozdzielczość komputera PC jest ustawiona na 
1920 x 1080 @ 60 Hz.

•	 Wyłącz komputer, odłącz stary monitor i 
podłącz monitor LCD Philips.

•	 Włącz monitor, a następnie włącz komputer.
P2:	 Czym jest zalecana częstotliwość 

odświeżania dla monitora LCD?
Odp.:	Zalecana częstotliwość odświeżania 

dla monitorów LCD wynosi 60 Hz. W 
przypadku jakichkolwiek zakłóceń obrazu 
można ustawić częstotliwość 75 Hz w celu 
sprawdzenia, czy wyeliminuje to zakłócenia.

P3:	 Do czego służą pliki .inf oraz .icm 
znajdujące się na dysku CD-ROM? Jak 
zainstalować sterowniki (.inf oraz .icm)?

Odp.:	Są to pliki sterownika monitora. Aby 
zainstalować sterowniki, należy wykonać 
instrukcje z podręcznika użytkownika. 
Podczas pierwszej instalacji monitora może 
zostać wyświetlony monit komputera 
dotyczący sterowników monitora (pliki .inf 
oraz .icm) lub dysku sterownika. Należy 
postępować zgodnie z instrukcjami w 
celu włożenia dołączonego do zestawu 
dysku CD-ROM. Sterowniki monitora 
(pliki .inf oraz .icm) zostaną zainstalowane 
automatycznie.
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P4:	 Jak wyregulować rozdzielczość?
Odp.:	Na dostępne rozdzielczości mają wpływ 

karta video/sterownik graficzny i monitor. 
Żądaną rozdzielczość można wybrać w 
oknie Control Panel (Panela sterowania) 
systemu Windows® poprzez “Display 
properties (Właściwości ekranu)”.

P5:	 Co należy zrobić w przypadku pomylenia 
się podczas regulacji ustawień monitora, 
przez menu OSD?

Odp.:	W celu przywrócenia wszystkich 
początkowych ustawień fabrycznych, 
wystarczy nacisnąć przycisk OK, a następnie 
wybrać 'Reset (Resetuj)'.

P6:	 Czy ekran LCD jest odporny ma 
zarysowania?

Odp.:	Ogólnie zaleca się, aby powierzchnia ekranu 
nie była poddawana nadmiernym wstrząsom 
i była chroniona przed ostrymi lub tępymi 
przedmiotami. Podczas przenoszenia 
monitora należy upewnić się, że na 
powierzchnię ekranu nie jest wywierany 
żaden nacisk ani nie działa żadna siła. Może 
to mieć wpływ na warunki gwarancji.

P7:	 Jak należy czyścić powierzchnię ekranu 
LCD?

Odp.:	Do zwykłego czyszczenia należy używać 
czystej, miękkiej szmatki. Do rozszerzonego 
czyszczenia należy używać alkoholu 
izopropylowego. Nie wolno używać innych 
rozpuszczalników, takich jak alkohol etylowy, 
etanol, aceton, heksan itp.

P8:	 Czy można zmienić ustawienie kolorów 
monitora?

Odp.:	Tak, ustawienie kolorów można zmienić w 
menu OSD, według następujących procedur,

•	 Naciśnij "OK", aby wyświetlić menu OSD 
(Menu ekranowe)

•	 Naciśnij "Down Arrow" (strzałkę w dół), aby 
wybrać opcję "Color" (Kolor), a następnie 
naciśnij "OK", aby przejść do ustawienia 
kolorów, dostępne są trzy pokazane poniżej 
ustawienia.
1.	 Color Temperature (Temperatura 

barwowa) Dwa dostępne ustawienia 
to 6500K i 9300K. Przy ustawieniach z 

zakresu 6500K wyświetlany obraz jest 
"ciepły, z odcieniem czerwono-białym", 
a przy temperaturze 9300K obraz jest 
"zimny, z odcieniem niebiesko-białym".

2.	 sRGB: jest to ustawienie standardowe, 
zapewniające prawidłową wymianę 
kolorów między różnymi urządzeniami 
(np. aparaty cyfrowe, monitory, drukarki, 
skanery, itp.)

3.	 User Define (Zdefiniowane przez 
użytkownika): użytkownik może wybrać 
żądane ustawienie kolorów, dostosowując 
poziom koloru czerwonego, zielonego i 
niebieskiego.

	 Uwaga
Pomiar koloru światła emitowanego przez 
podgrzewany obiekt. Pomiar ten jest wyrażony 
w skali absolutnej (stopnie Kelvina). Niższe 
temperatury Kelvina, takie jak 2004K, oznaczają 
kolor czerwony; wyższe temperatury, takie jak 
9300K, oznaczają kolor niebieski. Neutralna 
temperatura to kolor biały 6504K.

P9:	 Czy mogę podłączyć mój monitor LCD do 
każdego komputera PC, stacji roboczej lub 
komputera Mac?

Odp.:	Tak. Wszystkie monitory LCD Philips 
są całkowicie zgodne ze standardami 
komputerów PC, Mac i stacji roboczych. 
Do podłączenia monitora do systemu 
Mac może być konieczna przejściówka 
kabla. W celu uzyskania dalszych informacji 
należy skontaktować się z przedstawicielem 
handlowym firmy Philips.

P10:	 Czy monitory LCD Philips są Plug-and- 
Play?

Odp.:	Tak, monitory te są zgodne ze standardem 
Plug-and-Play w systemach Windows 8/7/
Vista/XP/NT, Mac OSX i Linux

P11:	 Co to jest utrwalanie obrazu, wypalanie 
obrazu, poobraz lub powidok na panelach 
LCD?

Odp.:	Wydłużone nieprzerwane wyświetlanie 
stałych lub nieruchomych obrazów, może 
spowodować na ekranie "wypalenie", znane 
również jako "powidok" lub "poobraz". 
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"Wypalenie", "poobraz" lub "powidok" to 
dobrze znane zjawisko dotyczące technologii 
LCD. W większości przypadków, "wypalenie" 
lub "powidok" albo "poobraz" znika 
stopniowo po pewnym czasie od wyłączenia 
zasilania.
Po pozostawieniu monitora bez nadzoru 
należy zawsze uaktywniać program 
wygaszacza ekranu z ruchomym obrazem.
Jeśli na ekranie monitora LCD wyświetlane 
są niezmieniające się treści należy zawsze 
uruchamiać aplikację okresowo odświeżającą 
ekran.

	 Ostrzeżenie
Nie uaktywnianie wygaszacza ekranu lub 
aplikacji okresowego odświeżania ekranu, może 
spowodować poważne symptomy "wypalenia" 
lub "poobrazu" albo "powidoku", które nie znikną 
i nie można będzie ich naprawić. Wspomniane 
uszkodzenie nie podlega gwarancji.

P12:	 Dlaczego tekst na ekranie nie jest 
wyraźny, a wyświetlane znaki są nieostre?

Odp.:	Twój monitor LCD działa najlepiej w 
oryginalnej rozdzielczości 1920 x 1080 @ 
60 Hz. Należy ustawić taką rozdzielczość 
dla uzyskania najlepszego obrazu.
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